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1. Introduction

The program YCompare performs automatic File Comparing about two CSV Files.

With this Software it is possible to create a documentation of all settings of the Yokogawa
TDLs.

For updates and changes about the program, please read the info file stored in the
installation folder or contact your Yokogawa sales team.

Note:
Please read this manual to find solutions!
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2. Revision

Date Version | Reason

02.2020 1 First creating
03.2020 2 Update all sheets
05.2020 3 Update all sheets
08.2020 4 Update all sheets
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3. System Requirements

3.1 Hardware

For the analysis using a PC, the following minimum hardware requirements must be met.

* Hard disk capacity: 30 MB
* Memory: 4GB

3.2 Software

The program YCompare is Windows based and requires therefore a Windows Operating
System.

3.3  Prerequirement

- Windows .Net Framework 4 Full installation (is checked by setup)
* http://www.microsoft.com/en-us/download/details.aspx?id=17718

3.4 Operating System

The program has been tested on the following platforms?:
- Windows 7 [32bit]
- Windows 7 [64bit]
- Windows 8 [64bit]
- Windows 10 [32bit]
- Windows 10 [64bit]
- Windows Server 2008
- Windows Server 2012
- Windows Server 2012R2
- Windows Server 2016

3.5 Additional Software
For using an Excel Template check the following requirements:
Microsoft Excel 2013 [32Bit] + [64Bit]
Microsoft Excel 2016 [32Bit] + [64Bit]

Microsoft Excel 2010 [32Bit] + [64Bit]
Microsoft Excel 365 [32Bit] + [64Bit]

! Microsoft Windows and Excel are a registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries
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4. Download

Load the latest version of our solution from the following web Page:

https://www.AdvancedTools.de
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5. Software Function

The software will be creating and comparing of two csv data files and show this as Excel
File.

The software is design as Excel Addin and will be started within the YCompare
Application. After starting the Software, it will be creating a new Tab/Ribbon right the
Home Ribbon.

AutoSave (@ Off) [% E;’

File Home Yokogawa Insert Page Layout Formulas Data Review

{%Settings (fa | :: E%’ ITI\

I
E Help [i] Yokogawa
Show Compare Compare Swap

TOLS Configuration Configuration measurement files Sheet Deutschland

Service TOLS Configuration heasurement data file compare Compare sheets
Al - Je

A B C D E F G H

1 |

—_—n
2

Excel Ribbon implementation
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5.1 Compare two TDLs Data value files

It is possible to compare the original *.rst files and also the converted *.csv files.

To start the compare function, press the Button. (1)

Within the new Form click the File Open Button beside the Textbox. (2)

By clicking the Button of the first file it can be select two files directly and the Comparing
procedure starts.

To change some settings like the Tolerance please press the Button to open the settings
Form. (3)

File Home Yokogawa Insert Page Layout Formulas Data Review View Developer Help Nitro Pro Team
{';::3 Settings = — |:r\1«
> G I o @ [
ﬁ Help Yokogawa
Show Compare Compare Swap
TDLS Configuration Configuration measurement files Sheet Deutschland

Semvice TDLS Configuration Measurement data'jle compare Compare sheets
Al T fe

A B C _d Yokogawa = O = L
I YOKOGAWA 4
* RST or *.CSV Data File o 7T X

second file (new) ] D:\WB Net_YCompare'_Samples’\Q875020_ 2020082011251 7\DATAN200702 rst o

|

|

! first file (old) ]D: \WB Net'_YCompare',_Samples\RE_ Yokogawa Tools_ Pesprechungsnotiz_ Yokoc

| d
) o

12 | j
13 | only compare column: 111},11,13 = —ﬁ Start comparing

) Open the compare Form

) Open files for comparing

) Check correct Column for comparing
) Start comparing

(1
(2
3
(4

After click at the Start button you will find two new Excel Sheets. The name of the sheets is

equal to the selected files.
If the value not equal between the first and the second file, it will be mark with background
colour. The colour can be changed within the settings form.

By selection of two files at first file open box, the compare function will be stating directly.
Otherwise, press the Start comparing Button.

8/19



YOKOGAWA Co-innovating tomorrow °©

BB = Cleve, Marko van ‘2' = 0

AutoSave lt‘ Off )

File Home Yokogaw Insert Page Lay Formulas Data Review View Develope Help Team Enterprisi 2 Search i -
EE L2k EZHep I:L‘l TRAIL VERSION Row:4 Column: 4
b |:_| > Values 71848 [171207.rst]
Show Compare Swap
Configuration data files Sheet Value: 204606 [171208.rst]
TDLs Configuration | Data File compare Swap sheets #
D4 - 5 204606 v
A B C D E F G H [ e
1 ESeriaI I~ Date " Time |~ Concl{ppy ~ | Concz[ppl;'-STD\.'ltppr__"_ STDVZ[ppI;' Transmission(§ ~ | Temperature{deg! v'_Pressd
2 | 523933 08.12.2017  00:00:01 205288 0 1238,29 0 59,7 ' 105,207
3 | 523934 08.12.20017  00:00:03 204967 o 1208,33 o 59,7 105,207
4| 523935 08.12.2017 00:00:05| 204506! 0 1216,42 0 59,7 105,207
5 | 523936 08.12.2017  00:00:08/ 204871 o 1215,77 o 59,7 105,203
6 | 523937 08.12.2017  00:0630 205744 0 1207,57 0 59,8 105,2
T | 523938 08.12.2017  00:00:13 206148 1] 1163,08 1] 59,8 105,204
8 | 523939 08.12.2017 00:00:15 206548 0 1108,34 0 59,8 105,207
) | 523940 08.12.2017  00:00:17 206570 o 1091,54 o 59,8 105,207
anl sj2a41 0213 2017 -00- INRTIR n 19495 n sa.8 ans N2 |i~]
171208.rst | 17120755t || Sheeti | @ [« v
= ' iz oo I + 100%

Compared Files

By clicking into a Cell, the software starts to compare this Cell with the same Cell at the
other file. So, it is possible to find difference between the data.

By clicking the Button “Swap sheet” it will be compering the two Cell data, show the Result
at the message box and change into the other sheet.
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5.2  Settings

5.2.1 Compare settings

Settings = |i|

o O pd
oo + E—

Compare settings ] Software seftings |

Colume Date |2 3: 0 = Keine Spalte formatieren C5V File delimiter |, | comma
Colume Time 13 5: [ = Keine Spalte formatieren CSVY Decimal Symbol | | Komma

Tolerance [%] |20 =

Caoler ][:I Agqua 'i
Colar JEI LawnGreen v]

X |

&
v

Settings Form

By using the CSV Import function of Excel, it comes to problems within the default Country
settings of the PC.
Within the settings form it can pe change the import functions for the CSV file:

1. Colum for the Date

2. Colum for the Time

3. CSV File Colum delimiter (US default: , comma)
4. CSV File Decimal Value delimiter (US default: . Dot)
5. CSV File Thousands Value delimiter (US default: , comma)

6. Tolerance %: if the Tolerance between the Cells > like this value, it will be mark with
the colour.

7. Colour for sheet 1

8. Colour for sheet 2

It can be set the tolerance between the Values of SCSV File 1 and CSV File 2.
The colour of the Detected difference background can be set also here.
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5.2.2 Software settings

[

Settings = = i

i e

Compare seftings  Software settings ]

Licence I
le ND ---------------------------- n
(—) i ! ) english _:J
E Name iTF-h"'\I LVERSION
241 22020 save seralno |
Error Handling

Software settings

Shows the Serial number and save the FULL Version Serial Number.

Change the Language of the software.
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6. Installation

Another method to enable macros in a file is via the Microsoft Office Backstage view,
the view that appears after you click the File tab, when the yellow Message Bar
appears.
1. Click the File tab.
2. In the Security Warning area, click Enable Content.
3. Under Enable All Content, click Always enable this document's active content.
The file becomes a trusted document.

The following image is an example of the Enable Content options.

o Enable All Content
o/ Always enable this document's active content

(make this a Trusted Document).

Advanced Options

Select which active content should be enabled,
This content will be enabled for this session anly.

Macro settings are in the Trust Center. However, if you work in an organization, the
system administrator might have changed the default settings to prevent anyone from
changing settings.
Important: When you change your macro settings in the Trust Center, they are changed
only for the Office program that you are currently using. The macro settings are not
changed for all your Office programs.

1. Click the File tab.

2. Click Options.

3. Click Trust Center, and then click Trust Center Settings.

G |
nera @ Help keep your documents safe and your computer secure and healthy.

Farmulas
Proofing Protecting your privacy

Save Microsoft cares about your privacy. For more information about how Micrasoft Excel helps to protect
your privacy, please see the privacy statements.

Language )
Show the Microsott Excel privacy statement

Advanced

Customer Experien Program

Customize Ribbon

Quick Access Toolbar Sewy i TN

Add-In Learn more about protecting your privacy and security from Office.com.

1l Microsoft Trustworthy Computing

Trust Center

Microsoft Excel Trust Center

The Trust Center contains security and privacy settings. These settings
change

help keep your computer secure. We recommend that you do not change ([ frugt Canter Settings..
these settings. =

ok || cancet |
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== =

General

Help keep your documents safe and your computer secure and healthy.
Formulas I
Data Security & more
Procfing Visit Office.com to learn more about protecting your privacy and security. |5 T u |
nave Microsoft Trustworthy Computin:
Language

Microsoft Excel Trust Center
Ease of Access

The Trust Center contains security and privacy seftings, These settings help keep your -
Advanced computer secure, We recommend that you do not change these settings, Trust Center Settings...

Customize Ribbon LE
Trust Center [EX = ? X

Quick Access Taalbar

Addeing =TT || Trusted Publishers i

| Trust Center !n i Trusted Locations l
f Warning: All these locations are treated as trusted sources for opening files. If you change or add & location, make
Trusted Documents sure that the new location is secure

Trusted Add-in Catalogs \ Path Description Date Modified
User Locations
Add-ins [ Program Files (86)\AdvancedReportv2\ ] 00220190837
% N Roaming \Microsofty £ E TUser T 4
ActiveX Setings P DatT Rearing Mierosof Temp stes, y Trcel Aefaul location: User Templote

rosoft Office\Root\Officel BLXLSTARTY
at\Roaming\Microsoft\Exce\ XLSTART\  xcel default location: User StartUp
3oNlicrosoft Office\Root\ Templatest  Ecel default location; Application Templates
icrosofQffice\Root\Office1E\STARTUPY  Exdel defoult location: Office Startlp
Microsof®Qffice\Roct\Officel@\Libran\,  Excdf defeult location: Add-ins

Excel default location: Excel StartlUp
Macro Settings.

Protected View

Message Bar
External Content Policy Locations
File Block Settings

Privacy Options

Path:
Description:

Ci\Program Files (861\AdvandedReportV2\

Date Modified: 09
Sub Folders: Allow

Add new location... ‘ Remove IModify...

[ Allow Trusted Locations on my network (not recommended)

[ Disable all Trusted Locations

ok || conce

Add the Application Path to the trusted location

6.1 YCompare Add In is not available

If Excel starts correctly, but the Ribbon isn’t available, please check the following

settings.
If the following Window shown, Click “Enable this Add-In..” .

Insert Page Layout Formulas Data Review

ks - - =

D 3 Cut = g = _

5 Egy Copy -

aste 4 - - =

- ¥ Format Painter Ty - -

Clipboard P Font ]
-
Microsoft Excel Security Notice ? X

@ Microsoft Office has identified a potential security concern.

‘Warning: There is no digital signature available.

File Path: | co\program Files (x86)\AdvancedReportV2\AdvRptExcelFit-
Addin-packed.xll

This application add-in has been disabled, Add-ins might contain viruses
or other security hazards,

More information o

| Enable this add-in for this session only. || Leave this add-in disabled.

1. Enable the Template Addin

To enable this Add-In all the time, please add the Installation folder to the trusted
location. Shown at the next picture.
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Gefieral O Help keep your documents safe and your computer secure and healthy,

Formulas

Data Security & more

Proofing Visit Office.com to lesm more about protecting your privacy and secuiity. | S R [ ]
Save Microsoft Trustworthy Computin

Langusge

Microsoft Excel Trust Center
Ease of Access

The Trust Center contains security and privacy settings, These settings help keep your
Advanced computer secure. We recommend that you da not change these settings, Trust Center Settings...

Customize Ribbon

Trust Center

Quick Access Toolbar

Addins =TT || Trusted Publishers
Add-ins rusted Publisher —
“Trust Center ° Trusted Locations |

Trusted Documents

rning: All these locations are treated as trusted sources for opening filss. If you change or add @ location, make
e that the new location is secure.

Trusted Add-in Catalags \ Eath Description Date Modified
User Locations

Add-ins [ SC:\Program Files (x86)\AdvancedReportV2\ ] os.042010 0837
o

PPData Roaming\Microsort. T ermplaten
Qrosoft Office\Root\Office] iXLSTART)
at\Roaming\Microsoft\Exce\XLSTARTY
osoft Office\Root! Templates\
Root\Office16\STARTUP!
\Microsof\Qffice\Root\OfficelB\Library),  Exc

Excel defaultlocation: User Templates

ActiveX Settings

Excel default location: Excel StartUp

el default location: User Startlp
plication Templates
| default location: Office StartUp

default location: Add-ins

Macro Seftings

el default location:

Protected View

Message Bar
Extemnal Content Policy Locations
File Block Settings

Privacy Options

Path:
Description:

Date Modified:
Sub Folders:

Remove Modify...

[ Allow Trusted Locations on my network (not recommended I
[ Disable all Trusted Locations

Cancel

Add the Application Path to the trusted location

Open the Trust Center:

File > Option (at the left bottom) >
Trust Center (1) > Trust Center Settings > Trusted Location >
Add new Location (2)>
Browse the AdvancedReportV2 installation folder - Select OK >
Close all Windows with OK
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7. Error handling

7.1 Solve Problem by yourself

If an error is recognized in the conversion or in general running of the program, this is
indicated by an “Alert window” and registered in the error log.

Note:
A 1. Please read this chapter to solve the problem.

2. Use the Error Handling routine before calling your Services
Team.

7.2 Software

During the conversion or in the generally running program if an error is recognized, this
is indicated by a reference display window and registered in the file error.log.

Please send the file with exact error report and if necessary, the file which can be
converted to the well-known email address.

If the programs running as a Service, the messages are also sent to the Windows event
logger (Control Panel - Administrative Tools > Events)

Create the Error Log by clicking the Error Handling Button:

File Home Yokogawa Insert Page Layout Formulas Data Review View Developer Help Team Enterprise Connect

= 1| EF el TRAIL VERSION
I [

£/ Vokooawa

¢ X
| M N o
1 = [m} X
2
3
1: 4
5 Compare settings  Software settings l
6 —Licence - e
7 = Licsnce No [ [ [ -~
8 o () 1english -
9| | i Name [TRAILVERSION
| i
:(1]' 24 .12.2020 m

15|

16 Error Handling
17|

18 1

o % | X

20 Zi

Sfart Error Handling routine
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7.3  Software YCompare Excel Addin

“l installed my Office solution (VSTO add-in) successfully but when | open the
Office application, my add-in does not load. What is the problem?”’

This is a common question which | came across many times in Forums. Here are simple
and quick checks that you can do before you start scratching your head or jump to the
Forums. I'll be using Excel as the Office application, but the approach is applicable to
others more or less.

7.3.1 Check out “COM Add-Ins” dialog in Excel

Now open Excel and see if your add-in loads successfully. If not, open Excel Options
dialog (File->Options) and navigate to Add-Ins tab.

- » , | |2 S|
General "1 s 2 = :
| [y View and manage Microsoft Office Add-ins.
Formulas |
Proofing Add-ins
|
Save Mame ~ Location Type o
Solver Add-in L. Microsott Uthcel\Uthceld\LibranA\SULVERASULVER.XLAM  Excel Add-in
Language Team Foundation Add-in "CALACommenTyIDEPrivateAssemblies\TFSOfficeAdd-in.dll*  COM Add-in 2
TUSReport? AX AddInConnect C:\Program Files (x86)\TUSReport2\ TUSReport2 AX.dll Excel Add-in
Advanced Wisual Studio Tools for Office Design-Time Adaptor for Excel Ch00Visual Studic Tools for Office's@6\WSTOExcelAdaptordll  COM Add-in
Customize Ribbon Document Related Add-ins ¥
No Document Reloted Add-ins
Quick Access Toolbar o
Disabled Application Add-ins
Add-Ins | Yokogawa TUSReport2 file:///...ort2/TUSReport2/bin/Debug/TUSReport? vstolvstolocal  COM Add-in ~
Add-in: Yokogawa TUSReport2
Trust Center 1 Publisher: <Meone=
Compatibility: Mo compatibility information available
Location: file:/ /i VB.Net/¥okegawa/_TUSReport2/TUSReport2/bin/Debug/TUSReport vsto|vstolocal
Description: Create a report for Nadcap organization. (c} by Yokogawa Deutschland GmbH; Germany (Dev. M. van Cleve)
Mgnage:(Exce\ Add-ins B Go... 5‘\
Excel Add-ins
Actions i
AML Expansion Packs ' ' " ' ' ' ' "

. .
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Excel Options

B =

Microsoft Excel Trust Center
Ease of Access

Advanced

Customize Ribbon

The Trust Center contains security and privacy settings, These settings help keep your

Genzral @ Help keep your documents safe and your computer secure and healthy.
Formulas

Data Security & more

Proofing Visit Office.com to learn more about protecting your privacy and security.

Save Microsoft Trustworthy Computin

Language

Guick Access Toolbar

Tru M

computer secure, We recommend that you do not change these settings

B

Add-ins __..--'"’-"-M,Frusted Publishers

Tusted Locations

Trusted Documents sure that the new location is secure.

Warning: All these locations are treated as trusted sources for opening files, If you change or add a location, make

| Description

| Date Modified ~

\
Trusted Add-in Catalogs

—=El 1OCAORNS
Add-ins

ActiveX Settings
Macro Settings
Protected View
Message Bar
External Content Policy Locations

File Block Settings

Privacy Options

Excel default location: User Templates
Excel default location: Excel StartUp
cel default location: User StartUp
el default location: Application Templates
Exdel default location: Office StartUp

Exce} default location: Add-ins

| 09.04.2019 08:37

Description:

Date Modified: 09.04.2019 08:37

Path: C:\Program Files (x86)\Advand¢dReportVZy

Sub Folders: Allowed
I Add new location... | | Bemove | | Modify...
[] Allow Trusted Locaticns on my network (not recommended) L\)
[] Disable all Trusted Locations
OK | | Cancel

Add the Application Path to the trusted location

17/19




YOKOGAWA

Co-innovating tomorrow ©

Trust Center

Trusted Publishers
Trusted Locations
Trusted Docurmnents
Trusted Add-in Catalogs
Add-ins

ActiveX Settings

Macro Settings
Protected View
Message Bar
External Content
File Block Settings

Privacy Options

ActiveX Settings for all Office Applications

) Disable all contrels without netification

B Prompt me before enabling Unsafe for Initialization (UFl) controls with additional restrictions and
Safe for Initialization (SF[) controls with minimal restrictions

) Prompt me before enabling all controls with minimal restrictions

® Enable all controls without restrictions and without prompting (not recommended; potentially
dangerous controls can run)

[] safe mode (helps limit the control’s access to your computer)

| OK | | Cancel

ActiveX Settings

Trust Center

Trusted Publishers
Trusted Locations
Trusted Documents
Trusted Add-in Catalogs
Add-ins

ActiveX Settings

Macro Settings

Protected View
Message Bar
External Content
File Block Settings

Privacy Options

Macro Settings

) Disable all macros without notification
) Disable all macros with notification
_) Disable all macros except digitally signed macros

® Enable all macros (not recormmended; potentially dangerous code can run)
Developer Macro Settings

Trust access to the VBA project object model

OK | | Cancel

Makro settings
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7.4  Microsoft KB articles on general Excel troubleshooting

« Excel: How to Troubleshoot Crashing and Not Responding Issues with Excel -
https://support.microsoft.com/en-us/kb/2758592

« Excel: How to troubleshoot crashing and not responding issues in an Excel Files -
https://support.microsoft.com/en-us/kb/2735548

Microsoft is quite explicit about not expecting any access to the COM object model from
either the function wizard, or an .xll worksheet function (async or not): (used to be
at https://support.microsoft.com/en-us/kb/301443 but now sadly no longer available...).

"A function that is defined in an XLL can be called under three circumstances:

1. During the recalculation of a workbook
2. As the result of Excel's Function Wizard being called on to help with the XLL function
3. As the result of a VBA macro calling Excel's Application.Run Automation method

Under the first two circumstances, Excel's Object Model does not expect, and is not prepared for, incoming
Automation calls. Consequently, unexpected results or crashes may occur.

In order to ensure that they function properly, no Automation calls should be made from an XLL. Instead, all
commands to Excel from the XLL should be sent using the Excel4() C APL."
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